INSTANT READERS

On-line Teacher’s Guide

HARCOURT
=== BRACE



CONTENTS

Click on a section to go to it.

* Welcome to the INSTANT READERS™ CD-ROMs

» Getting Started

Macintosh Installation and Start-Up
System Requirements
Optional Equipment
Installation Instructions

Windows Installation and Start-Up
System Requirements
Optional Equipment
Installation Instructions

» Using the INSTANT READERS CD-ROMs
Main Menu
Book Menu
Look Screen
Read Screen
Play Screen
Word Walk
Phonics Fling
Letter Press
Think Twice
Color Write
Game Directions
Word Walk
Phonics Fling
Letter Press
Think Twice
Color Write
Teacher Options
Student List and Class List
Printing Options
Recording Option
Saving Options
Language Support Options

Harcourt Brace School Publishers

D O o0 O 01 01 01 01 U1

©O© 00 N

10
11
12
12
12
12

12
13
13
14
15
16
17

18
18
18
18
18
18



* Using the Teacher Options — Macintosh and Windows
Student List and Class List
Printing Options
Recording Option
Saving Options
Language Support Options
» Teacher Resources
Running-Record Forms
Word Cards
Using the Word Cards

» Classroom Management
Classroom Formats
One Computer
Several Computers
Computer Lab

» Assessment
How to Do a Running Record
Emergent Writing
Observing the Emergent Writer
Observation Guides:
Familiarity with Reading and Writing
Emergent Writing

* Meeting Individual Needs

Strategies
Look
Read
Play

Activities
Extra Support
Students Acquiring English
Challenge

Harcourt Brace School Publishers

19
19
19
20
20
20
21
21
21
21

24
24
24
24
24

25
25
29
31

32
34

36
36
36
36
37
39
39
39
39



* Viewing and Printing Teacher Resources
Viewing Teacher Resources
Printing Teacher Resources

Words Cards and Running Records

» Software License Agreement and Limited Warranty
Additional Discs

Warranty and Replacements

Technology Service Hotline

» Appendix -INSTANT READERS at a Glance

Level 1-1A
Level 1-1B
Level 1-2A
Level 1-2B
Level 1-3A
Level 1-3B
Level 1-4A
Level 1-4B
Level 1-4C
Level 1-5A
Level 1-5B
Level 1-5C

Harcourt Brace School Publishers

40
40
40
40

42
42
42
42

43
43
44
45
46
47
48
50
52
54
56
59
61



Welcome to the INSTANT READERS™ CD-ROMSs

The INSTANT READERS are accessible and predictable
patterned books that develop reading fluency and
confidence, making children feel like real readers almost
instantly. The complete first grade program, on twelve
CDs, includes a set of 64 electronic books divided into five
levels. Each INSTANT READER is also available as a printed
book. The INSTANT READERS CD-ROMSs can be used with or
without the printed books. The computer-assisted
independent reading practice provided on these CD-
ROMs enhances the emergence of virtually all children as
independent readers, but proven intervention strategies
make these little electronic books especially valuable for

underachievers.

Delightful experiences before, during, and after reading
provide valuable reading support:

Play

LOOK

The Look section of each book provides a preview of the book's
story line and sentence patterns. Through Look, children gain an
idea of what they will encounter when they try to read the book
independently—helping ensure that their reading experiences will
be successful.

READ

In Read, children have the option of reading the book indepen-
dently or hearing the book read aloud. They can also record and
listen to their own reading. Teachers can keep students' record-
ings as a kind of electronic portfolio.

PLAY

In Play, children can choose from learning games directly related
to the book they've just completed. These games reinforce read-
ing comprehension, phonics, word recognition, reading fluency,
spelling, and writing. Every book includes an activity in which
children can paint a picture and write a story that the computer
reads to them!

Because of the program’s highly intuitive interface, all of these activities are easily accessible even
to the novice computer user — and audio instructions are available in English and Spanish!

Harcourt Brace School Publishers 4




GETTING STARTED

Macintosh® Installation and Start-Up

System Requirements

* Macintosh Il Family/System 7.1 or above

« 5-MB RAM (8-MB RAM for recording)

» Hard drive

* CD-ROM drive (double-speed, or faster, recommended)
* 640X480 256-color monitor

Optional Equipment
* Printer
* Microphone

Installation Instructions
1. Close all applications before running the INSTANT READERS CD-ROM.

2. Insert the CD into your CD-ROM drive. The INSTANT READERS icon will appear on your Desktop.
3. Double-click the INSTANT READERS icon to start the program.

NOTE: This program requires that Sound Manager and Speech Manager be installed in the System
folder. These extensions are part of System 7.1. We have included these extensions on the CD
should you need them. To install Sound Manager and Speech Manager drag the icons onto the

System folder on your hard drive (You will need to install Sound Manager and Speech Manager only
once.) Now restart your machine.
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Windows® Installation and Start-Up

System Requirements

486 CPU 33Mhz

e Hard drive

e 8-bit sound card

e 640X480 SVGA 256-color monitor

« CD-ROM drive (double-speed, or faster, recommended)
e Windows 3.1

Optional Equipment
e Printer
*  Microphone

Installation Instructions
1. Close all applications before running the INSTANT READERS CD-ROM.

2. Insert the CD into your CD-ROM drive.

3. Choose Run from the File menu in Program Manager; or, if you are in Windows 95, choose
Run from the Start menu.

4. Type x:\Setup.exe (replacing the initial “x” with the name of your CD-ROM drive).
5. Double-click the INSTANT READERS icon to start the program

NOTE: The INsSTANT READERS CD-ROM icon will be installed in a Program Group named
“INSTANT READERS.”
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Using the INSTANT READERS CD-ROMSs

MAIN MENU

The Main Menu displays the books that are available on this CD-ROM. The simple interface
allows young children to navigate with ease.

Hear about a book.
Go to the book.

Get help.
Exit the program.
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BOOK MENU

The Book Menu shows the activities available for the book.

r - ‘\..-.J'q‘:!i:" . o
yi—wm Read the book.
Children can listen
to the book or read
it independently.

viwy

Preview the book. ¥ ! Play reading games
" @: s directly related to

-wmahya_m:.nmr . the book.

Get help.
Go back to the

Main Menu.
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LOOK

Look previews the basic story line and introduces sentence patterns in the book. Giving
children an idea of what they will encounter in a book helps ensure a successful reading

experience.

Hear about the page.

Return to the
previous page.

Get help.
Return to the Book
Menu to select a
new activity.
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READ

In Read, children can choose to read the book independently or have it read to them.

Children can click on the button and have the
text read to them. As the text is read, the words
are highlighted. This reinforces that reading is
"talk written down." Children can also click on
an individual word and hear it read. These

features provide children with individualized
word support.

: v
¢ s

If the teacher selects the Record Option,
children can record their reading of a page
by clicking on the microphone, and then
listen to their recording by clicking on the
headphones. This recording can also be
saved for the teacher to listen to later.
Directions for completing running records
of children's reading progress are
provided in the Assessment section of this
Teacher's Guide.

[ © The tigers climb up. © The bears climb up.

Return to the Book
Menu to select a

Go on to next page.

new activity.
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PLAY

In Play, children can select the game they want to play. Each game reinforces the skills,
strategies, and concepts in the book it accompanies.

@ Word Walle

Phonics Fling

g@@ﬂ@r Write ]
E ]

Play

o/
XK ;8

Select a game.

|

Return to the Book
Menu to select a
new activity.
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PLAY

Options in Play include:

WORD WALK

A scrambled sentence from the book
appears on the screen for children to
unscamble. This activity develops the
concepts of words and sentences—and
reinforces reading comprehension.

PHONICS FLING

Word Walle

This arcade-type game develops children's
knowledge of phonograms and individual
sound/letter relationships.

LETTER PRESS

In Letter Press, children have the opportunity
to spell words they are learning to decode and
form picture-word cards. This activity helps
children see the relationships between reading
and writing.

THINK TWICE

This memory game builds thinking skills as
well as reading comprehension, word recogni-
tion, and phonics skills.

COLOR WRITE

Children electronically paint and then write
about an illustration from the book. They will be
delighted to discover that the computer can
read aloud what they have written! Words from
the book that children may want to use in their
stories appear in the Color Write Word List.

Harcourt Brace School Publishers
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Game Directions

This section shows you how to play the games that are listed on the Play Menu.

WORD WALK

A sentence that tells about the picture appears on the rope. Then the sentence is
scrambled. Put the sentence back in order by dragging the word tiles up to the rope.

: _ Click and drag the word tiles up
Click here WM Click the gate to to the rope to put the sentence
to get help. i check your answer. back in order.

@fzigﬁ’[;;; . — —h
M L e S B A E SRR R /A

e e e - S, S e 'R S A T— R, b ik, L T

Click here to

return to the Play NOTE: As needed, on-screen assistance is provided to
quide children in answering correctly.

Menu to select a
new activity.
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PHONICS FLING

Match each picture to the letters in its name.

Click on the picture to Use the uE and down arrows

hear the word repeated. to move't

]TEDIE]. U]

e picture.

nics Fling

g il
=8
=
ot

Click here to Use the white arrow Click here to
to fling the picture. get help.

return to the Play
Menu to select a
new activity.
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LETTER PRESS

Spell the name of each picture.

Click on the picture to hear

Click on the red handle
the word repeated.

to check your answer.

\

Click and drag the correct letter

Click here to tiles between the press to make Click here to
return to the Play the word. get help.
Menu to select a

new activity.
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THINK TWICE

Find the two tiles that go together.

Click on the tiles to find
a matching pair.

Thi

Click here to
return to the Play
Menu to select a
new activity.
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COLOR WRITE

Color a picture from the book. Then write about the book.

Click here to open the

: Click on a color. Then Word List. Click on a
Click on the dot click on the part of word to hear it read.

to hear your the picture you want Click here again to
story read aloud. Mt paint that color. close the Word List.

|
[ ]
e — e ————— N\
These wolves are howling. They
like to howl together.

l.;} WORD LIST

—

Use the keyboard on Click here to
your computer to get help.

Click here to type your story.

return to the Play Click here to print

Menu to select a your story and picture.
new activity.
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TEACHER OPTIONS

The Teacher Management functions allow you to determine a variety of options for your
class. To access the Teacher Management functions from any screen, press the
Control-Option-Shift keys (Macintosh) or press the Alt-Control-Command keys (Windows).

Children can print an outline of their Color
Write stories which they may color at their
desks or at home. The computer will

automatically print black-and-white line-art

unless the option for grayscale/color is
selected. When the grayscale/color
printing option is selected, the illustration
prints as it was painted on the computer.

STUDENT LIST

Becky
loey

Linda,
Susan
Faobert
Errira,
Coaveicd

]

| Add aMame |

CLASS LIST

fdarms
Jones
Smith
Williams

[ AddacClass |

]

How 1o Input and Delete Daty

PRINTING OPTIONS /
] Allow Printing /

X

® B/W Line Art

o GrayscalafCalar

RECORDING OPTION
# Enable Audio Recording

A Aeguires microphone

and & MBs of RAM.

SAVING OPTIONS \
<] Save Color Wrile text into text file
| on the hard disk.

1 Save Audio Recording to hard disk,

A\

LANGUAGE SUPPORT OPTIONS

 English — )} Espafiol —  Student’s\Cholce
| /

Requires 1 Magabyte of froee Nard
drive space par studant par Cp.

Save and Exlt

When the Saving Options are
activated, the program
automatically saves children’s
Color Write stories and/or the
recording of their reading.
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When the Language Support Options
are activated, children can hear the
directions in English or Spanish.

When the Recording Option is
activated, children can record
their own reading of a book.
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Using the Teacher Options

Macintosh and Windows

Student List and Class List

Creating a Student List and Class List activates the Find Your Name screen. This screen allows
students to sign on, which enables the program to track students’ work by saving it in individual
folders.

How to Input and Delete Data Button
A Help screen appears with information on how to input and delete class and student information.
Click anywhere on the screen to exit the Help screen and return to the Teacher Options.

Creating a Class List
To create a Class List, click the Add a Class button. When the dialog box appears, enter the
class name, and click OK.

Creating a Student List
To create a Student List, highlight the Class name that will contain the Student List and click the
Add a Name button. When the dialog box appears, enter the student’'s name, and click OK.

Deleting a Class Folder

To delete a Class folder, use the Finder (Macintosh), File Manager (Windows 3.1) or Winfile
(Windows 95) to open the Classes folder under “Instntgl.” Select the Class folder you want to
delete and use the System’s delete function.

Deleting a Student Folder

To delete a Student folder, open the Classes folder under “Instntgl” and open the Class folder
containing the student folder you want to delete. Select the student folder and use the System'’s
delete function.

Printing Options

A printer icon appears on the Color Write screen. Click the icon to print the Color Write stories.
The computer will automatically print black and white line-art unless the option for grayscale/color is
chosen.

Black and White
Selecting the B/W Line Art option prints out the Color Write picture in line-art. This enables
students to color their own pictures.

Grayscale/Color

Selecting the Grayscale/Color option prints out the Color Write picture in color when using
to a color printer and in shades of gray when using a black and white printer.
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Recording Option

For audio recording, your computer will need a microphone and 8 MBs of RAM. Students are able
to record and listen to themselves reading the book. After students leave the book, their audio
recordings are erased. If you want to save student’s recordings, see “Saving Audio Recordings”
below.

Saving Options

Saving Color Writes

To enable the automatic save function, select the Save Color Write text. The Color Write text

is saved as a text file under the student’s folder in the “Instntg1” folder. Your computer will need at
least 1 MB of free hard drive space per student per CD-ROM to save Color Write text.

Reading Color Writes

The file can be opened from any word processing program. You can also double-click on the
file to open it in Simple Text, the Macintosh System’s word processing program, or Notepad, the
Windows System’s word processing program.

Saving Audio Recordings
To save students’ audio recordings, click Save Audio Recording. Your computer will need a micro-
phone and 8 MBs of RAM.

Listening to Audio Recordings

To hear a student’s audio recording, enter the program under the student’s name and enter

the name of the book you want to review. Enter the Read section, and click on the headphones icon
to listen to the student’s reading of the book.

Saving and Exiting Teacher Options

When you have completed selecting the Teacher Options, click the Save and Exit button. The
Student List and Class List are saved on the hard drive in the “Instntgl” folder. Each student’s work
Is saved in a folder after he or she signs on.

Language Support Options

The program’s audio directions defaults to English but you are able to change it to Spanish by
selecting, Espafnol. The Student’s Choice option activates the Language Menu which allows
children to choose the language they want to hear.

After the Teacher Options are selected and saved, any CD from the series will access this data.
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Teacher Resources

The following resources are included with this Teacher’s Guide in the Resource folder on this
CD-ROM:

Running Record Forms

The complete text of each book is available in the Resource Folder located on this CD-ROM. These
materials can be used to complete running records of children's reading progress. Directions for
administering running records appear on pages 20-23 of this Teacher's Guide.

Word Cards

Word cards of all the Color Write Word List words are available on this CD-ROM. These cards can
be used in the sentence-building activities and games described in this Teacher's Guide.

Using the Word Cards

Word cards of all the Color Write Word List words can be printed out for use in your classroom. The
following off-computer activities and games provide practice with the word cards. Choose the activity
best suited to the specific words children are practicing as well as to the needs of the particular
group of children. Word cards may also be sent home for children to play any of these activities and
games with their families.

Building Sentences

In preparation for this game, prepare enough punctuation cards for each small group or pair of play-
ers. Give each group or pair a lunch bag filled with word cards and punctuation cards. Be sure each
bag of cards includes nouns, adjectives, articles, and verbs. The object of the game is to make as
many sentences as possible out of the word cards in the bag. When the time is up, children read
their sentences aloud. The winner of the game is the group or pair with the highest number of com-
plete sentences.

Let's Fish!

To begin this game, place some word cards in a lunch bag. Invite small groups of children to take
turns “fishing” by drawing a word card from the bag, reading the word, and using it in a sentence. If
the child uses the word correctly, he or she keeps that word card. If the word is incorrectly read or
used, the word card returns to the bag. The child with the most “fish,” or word cards, wins the game.

Sentence Strips

To prepare for this activity, create several sentence strips based on the stories and the word cards.
Display a sentence strip and a random assortment of word cards, including all the words used in the
sentence strip. Read the sentence aloud. Then ask volunteers to find each matching word card and
place it over the word in the sentence strip.
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Role-Play Fun!

For this activity, choose cards that are action words or naming words. Challenge children to pick one
card from a bag of word cards and dramatize the meaning of the word for their classmates.
Volunteers try to guess the correct word and use the word in an oral sentence of their own.

Make a Riddle

Have children work in pairs for this activity. Give a word card to each pair and challenge them to
make up a riddle for the word. Then have pairs exchange and solve each other's riddles. Offer chil-
dren one or two examples before they begin working in pairs. For example, | am the opposite of
large. | am . (small)

Bingo

For this game, give each child a sheet of paper on which a grid of eight squares has been drawn.
Each child chooses eight word cards from the word card pack, writes a word in each of the spaces
on the grid, and returns all the word cards to the pack. To play, choose a word card at random from
the pack, read it aloud, and set it aside. If children have that word on their grids, they mark an X on
it. The game continues until the first child to mark all his or her words calls out “Bingo." That child
wins if all her or his words match the cards that have been set aside.

Memory Game

For this game, print out two sets of identical word cards for each pair of children playing the game.
Have each pair of players place the cards face down on a desk. Explain that children will take turns
turning over two cards at a time and reading the words. The object of each round is to try to match
two identical word cards by remembering where the cards are placed on the desk. When a match is
found, the player removes the two cards from play and keeps them in a personal pile. When a
match is not found, the player turns the cards face down again. The player with the most pairs of
cards at the end of the game is the winner.

Sorting Phonograms

For this activity, label three or four lunch bags with different phonograms. Display a selection of word
cards that use each phonogram. Then challenge groups of children to sort the word cards by phono-
gram, read the words on the cards, use each word in a sentence, and then put the word cards into
the correct bags.

Guess that Word!

For this game, give a set or bag of word cards to each small group of players. In each group, a play-
er chooses a word card from the set and gives clues about the word to the other group members.
For example, a child might give the following clues: | eat this food in the morning. The word begins
with e. The player who guesses correctly chooses another word to put into play.

Cloze Fun

Display a random selection of word cards. On the chalkboard or on chart paper, write a context sen-
tence for each word card displayed, leaving a blank in place of the word. Challenge children to com-
plete each sentence by choosing the appropriate word, taping it on the blank space, and reading the
sentence aloud. To extend the activity, provide pairs of children with different word cards and chal-
lenge them to create a context sentence for each of the cards. Children should exchange papers
and word cards with other pairs of children and complete each other's sentences.
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Picture It!
Provide children with a random number of word cards. Invite them to choose one or two cards to
illustrate. Children may draw the illustrations on the backs of the cards or on chart paper.

Fun with Labels

To prepare for this activity, choose groups of word cards that describe pictures. Then draw a picture
on the chalkboard and invite children to use the word cards to label the individual parts of the pic-
ture. For example, you might choose word cards that could be used to describe a snowman. Then
draw a snowman on the chalkboard and ask children to use the word cards to label its hat, head,
nose, eyes, and so on. Children may tape the cards to the correct parts of the snowman.
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Classroom Management

Teachers involved in technology-based learning environments have found that the way in which their
classrooms are organized affects student learning. When planning the most effective way to use the
INSTANT READERS CD-ROMS, evaluate variables such as the number of children you teach, their indi-
vidual needs, and the number of computers available in your classroom or computer lab.

Classroom Formats

One Computer

If your classroom has one computer, you may choose to set up a computer center as one of your
learning centers. Try to place the computer in a quiet location, protected from screen glare caused
by windows and overhead lights. Individual children can work on the INSTANT READERS CD-ROMS as
their classmates are working in the other centers.

One way to find time to observe children’s work on the computer is to assign individuals computer
time while other children are engaged in independent reading and writing. Also, while you are work-
ing in small groups, children who are not engaged in the group work can take turns using the
INSTANT READERS CD-ROMSs. When working on a skill with the majority of children in a large group,
individuals who are not ready to learn that skill, or who have already mastered it, can work indepen-
dently at the computer.

To lessen the classroom time it takes to introduce the program, consider modeling the INSTANT
ReADpeErs CD-ROMSs program to a group of four or five children. Each of these children can then
become a “computer tutor” to two or three other children. The computer tutors can, in a short time,
introduce the entire class to the INSTANT READERS CD-ROMS.

Several Computers

If your classroom contains two or more computers, you can use the suggestions for one computer
by expanding the number of individual users. You can also work at the computers with small groups
who need background or extra support before reading a particular INSTANT READERS CD-ROM book.

One important note: If you are using the Teacher Options, each child needs to use the same com-
puter for every INSTANT READERS CD-ROM session. In this way, each child’s records will be updated
in the “Instant” folder.

Computer Lab

If children are using the INsTANT READERS CD-ROMSs as a group in the Computer Lab, demonstrate
how to sign on to the same computer each time. Remind children to follow the Computer Lab rules.
Suggested rules include speaking softly, checking with the teacher before recording or printing, and
touching only the mouse and keyboard.

In any of these possible computer configurations, support staff may be of great help in working with
children who have individual needs. For example, a special needs teacher in your classroom might
work at the computer with a small group based on instructional needs. Paraprofessionals and adult
volunteers can teach children basic computer operations, including how to record their readings.
They can also listen to children’s responses to each book and help them brainstorm writing topics
for the Color Write section.
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Assessment

How to Do a Running Record!?

A running record is a procedure used to learn about a child’s oral reading. The goal is to learn as
much as possible about the child’s reading strategies. To begin, have a child read aloud, and while
the child is reading, record everything he or she says and does.

The best approach is to have a child choose an INSTANT READER, or another type of selection, that
he or she would like to read. Print out a copy of the text of the INSTANT READER from the Resource
folder on this CD-ROM. When the child is finished reading, check the child’s comprehension by dis-
cussing the book or by asking the child to tell about the book.

Many teachers find it helpful to tape-record the child’s oral reading. That way, if the child reads
rapidly or you miss what the child said, you can refer to a record of the child’s performance. The
Record option in Read can be used to record children's readings.

NOTE: You must use the Teacher Options to enter students' names and to enable recording and
saving.

There are many systems for marking oral reading errors, or miscues. You should use the system
you are most familiar and comfortable with. If you are not accustomed to marking reading miscues,
the following chart lists the major types of miscues, suggests how they can be marked, and shows
marked samples.

1 The concept of a running record was developed by Marie Clay and is explained more fully in her
book An Observation Survey of Early Literacy Achievement, Portsmouth, NH: Heinemann, 1993.
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Marking Oral Reading Miscues

Reading Miscue

. omissions

. insertions

substtutions

. mispronunciations

. self-corrections

. Tepeliiions

- punciuation

. hesitations

Marking

Circle the word,
word part, or phrase
ormthed.

Insert a caret (™) and
write in the inserted
word or }:rhraae.

Write the word or
phrase the student
substitutes over the
word or phrase in the
lext.

Write the phonetic
mispronunciation
over the word.,

Write the letters SC
next to the miscue
that 15 self-corrected.

Draw a line under
any part of the text
that is repeated.

Circle punctuation
missed. Write many
punctuation inserted.

Place vertical lines at
places where the
student hesitates

excessively.

Sample

I will let you ,g@} in.

) i {'Il
Weboughta, -

parrot,

1 |':'; 2.

ad fixed my bike,

JI.I'::-"L-":IEJ\
IHave you fed the
dog?
4ot

e

We took our Elpacu.

It is your garden
IO W -

Take them ham:g.‘:]
Then come back .
and you and T will
g0 bo towin.

Pruh:nd‘rl:his 15
mine, !



A running record is not intended to yield scores. Scores for this type of assessment would not have
much meaning. Instead, the focus should be on a qualitative interpretation of the child's perfor-
mance. What strengths and weaknesses does the child exhibit? How can instruction be adjusted to
meet this child’s needs?

Analyzing Reading Miscues

What should you look for when you review and analyze the oral reading miscues the child made?
Listed below are four basic guidelines you should follow:

1. How many miscues did the child make?

The total number of miscues the child made will give a general indication of the child’s ability to
process material at the tested level of difficulty. You can quickly calculate a child’s error rate by divid-
ing the total number of miscues (not counting self-corrections) by the total number of words in the
book.

For instructional material, the error rate should be 10 percent or lower; for independent reading, the
error rate should be 5 percent or lower. If the error rate exceeds 10 percent, the child may have diffi-
culty reading and learning from material at this level.

Because not all miscues are of equal value, the error rate must be interpreted cautiously. For exam-
ple, if many of the child’s miscues are meaningful and do not alter the author’s intended meaning, a
higher error rate can be tolerated.

2. What types of miscues did the child make?

More important than the number of miscues is the type of miscues the child made. Look for patterns
in the types of miscues that the child made.

Note this basic distinction that will help you analyze the types of miscues made: Some miscues rep-
resent attempts to maintain or preserve the author’s meaning; other miscues represent attempts to
maintain the graphic or sound similarity of the author’s words. The following examples help illustrate
this distinction.

Child A:

“Oh, pretty Peacock,” asked Bess, “don’t you think the
clever

owl is a very smart bird?”

Child B:

“Oh, pretty Peacock,” asked Bess, “don’t you think the

small
owl is a very smart bird?”
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Child A substituted clever for smart, a logical substitution in the context of the book and one that
preserves the author’s meaning. Child B, however, unable to readily identify the word smart, substi-
tuted small for smart. These two miscues suggest a difference in the strategies used by these
students. Child A seems focused on meaning and will sacrifice graphic and sound similarity to
preserve it. Child B, on the other hand, seems focused on pronouncing words that are graphically
similar to the author’s even when it means sacrificing meaning.

It would be inaccurate to draw conclusions on the basis of one miscue. The example is meant to be
illustrative only. You should examine all of the child's miscues as you attempt to discover patterns.

3. Does the child self-correct his or her miscues?

Another feature to consider when examining your record of the child’s oral reading is the number of
self-corrections. Does the child attempt to self-correct miscues that disrupt meaning or do not make
sense?

Self-corrections can be an indication that the child is monitoring his or her reading and attempting to
construct meaning. But not all self-corrections reflect a concern for meaning. In examining the
child’s self-corrections, you should make the distinction between those that are necessary to pre-
serve meaning and those that are unnecessary or are focused on preserving a similarity to the
graphics and sounds of the text.

4. How fluently does the child read?

Oral reading fluency has become an important part of many elementary reading problems. Children
who can read fluently tend to be more automatic in their oral reading. They can devote more of
their mental energies to the meaning or message of what they are reading than to the actual
pronunciations of words. Children who are less fluent tend to devote more attention to word-level
pronunciations at the expense of meaning.

When judging fluency, look for features such as the following:

the pace or rate at which the passage was read;
the expression or intonation in the child’s voice

After the running record activity is completed, you can review it and note the child’s reading
strategies and miscue patterns.

By paying attention both to the miscues and the child’s comprehension of the book, you can deter-
mine a great deal about a child’s use of reading strategies to construct meaning. This information
can be very valuable in planning reading instruction. In addition, by collecting these running records
over the course of a semester, you can determine how effective your instruction has been and how
the child is developing as a strategic reader.
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Emergent Writing

Not too long ago, many educators believed children had to be well versed in reading and “readi-
ness” skills before they could write. We now know

» Children know much more about print, and at an earlier age, than we ever gave them credit for
in the past.

» Children discover that writing is oral language in written form. What can be said can also
be written.

* Emergent writers experiment with writing long before they’'re independent readers, and what
they learn about print from shared reading is reflected in what and how they write. Reading and
writing develop together.

* Young children who see writing modeled at home and at school are eager to try it on their own
and quickly come to view themselves as writers with something important to say.

» Beginning writers progress through predictable, recognizable stages that will vary in duration for
individual children. Since these stages are not rigid, examples from more than one stage will
often appear in the same piece of writing:

1. Scribbling, or pretend writing, is not necessarily random marks on the page. It may be a child’s
first attempts to approximate the print he or she encounters naturally all day long. Listen for the
running monologue that may accompany a child’s scribbling; this child is well aware that written
symbols contain meaning!

2. Letter strings, or random letters, are a child’s attempts to mimic the forms of our alphabet. At
this prephonemic stage, letters do not yet represent sounds. More often than not, the child will
use capital letters. You may notice that a child at this stage is already practicing left-to-right and
top-to-bottom progression on the page.

3. One-letter spelling is a common occurrence in the early phonemic stage. Here a child uses the
initial consonant, and perhaps another distinctive consonant, to represent an entire word, such
as b for baby or bl for believe.

4. Invented spelling is a window on a child’s understanding of sound/symbol correspondences.
Children who are encouraged to “spell a word the best they can” experiment with beginning and
ending consonants and often medial sounds as well. Usually vowels come much later, although
all-important words like | and a appear early in a child’s writing vocabulary.

5. Transitional spelling is the stage in which children adjust their own simple spelling rules (shz
for shoes, wans for once) to accommodate what they're learning from their reading. Features
such as double consonants and silent letters also begin to appear.

6. Conventional spelling might begin to be used for a few high-frequency words. Extensive use of
conventional spelling is not typical of early writers.
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Some children have had extensive experience with writing before they entered school; others may
be experimenting with crayons and pencils for the first time. You can promote children’s emergent
writing by

* modeling writing behaviors every day.

» providing writing supplies in learning centers.

* encouraging children to make their own signs, lists, recording sheets, captions, etc., when they
need them.

» setting aside time for children to keep personal journals, to write individual and group stories,
and to respond to literature in writing.

» celebrating the efforts of emergent writers.
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Observing the Emergent Writer

Learning to write is both individual and developmental. The emerging writer figures out how lan-
guage works through observation and exploration. Children need time and ample opportunities to
progress at their own pace in a low-risk environment. They need many experiences with print to
acquire understanding of the basic principles of written language—how it works and how they might
use it to communicate.

Two observation guides provided in this manual may be used to record children’s progress in lan-
guage development.

The first observation guide (“Familiarity with Reading and Writing”) helps you document observable
behaviors that reflect a child’s reading and writing experiences, attitudes, and interests. It will help
you know which of your children have had experiences such as being read to, discussing stories,
selecting books, and writing their own stories with pictures and emergent writing. These experiences
are not reading and writing, but they are indicators and lay the groundwork for the development of
habits, behaviors, and positive attitudes that lead to reading and writing.

This observation guide is provided to help you get started. After the first few weeks, all your children
will have experiences with books, reading, and writing because you will have provided them with the
opportunities. The information the guide provides will help you know where to begin, what you might
expect, and what experiences you need to offer.

The second observation guide (“Emergent Writing”) helps you document progress in the following

areas:

» Developing language and story understanding: Children who can talk about stories, embellish
the stories they have read or heard, and make up their own stories are almost certain to become
capable writers. For those who are not able to discuss and make up stories with you and their
classmates, you will need to plan activities that will give them opportunities for story-telling and
story discussion. This area includes both listening and talking since story understanding and
discussion includes both listening and speaking.

* Producing written language: As children tell their stories and become interested and excited
about story events and story characters, they will turn to a variety of art activities to model
their stories. Clay figures of story characters, masks that represent story characters, and
drawings that reflect their personal interpretations of a story or a story incident are all part of the
development of written language.

With your guidance, these activities will naturally lead into beginning writing activities in which
pictures and letters are joined on paper, pictures are labeled, and words are added to show what a
pictured character may be saying. These are the emergent writing behaviors that you need to
assess and to encourage. You will need to have a means to collect this information as you do
shared writing with your children and as you have the children do follow-up activities to stories you
have read with them.
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Child’s Name

Teacher’s Name

Familiarity with Reading and Writing

N = Not observed
O = Observed occasionally
R = Observed regularly
Pretends to read
Holds a book correctly
Knows directional movement
Front to back
Left to right
Top to bottom
Listens and responds to stories
Draws pictures about story characters
Uses pictures to tell a story
Retells familiar stories

Chooses favorite books and stories

Uses clues from book title and cover
illustration to make predictions

Dictates captions or stories about pictures
Recognizes that print carries meaning

Recognizes concepts about print
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Letter
Word
Sentence
Question
Capitalization
End marks
Thinks of self as a writer
Enjoys telling stories
Writes letter-like shapes and random letters
Talks about drawing and writing

Copies letters/words

Comments
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Child’s Name

Teacher’s Name

Emergent Writing

N = Not observed
O = Observed occasionally
R = Observed regularly

Date

WRITING STAGES

Scribbles and pretends to be writing

Date

Date

Knows directional movement

Uses letters and/or pictures to tell or retell a story

Embellishes familiar stories with new events
or new characters

Uses one-letter spelling

Listens and responds to stories

Uses conventional spelling most of the time

beginning and final consonants

medial consonants

medial short vowels

medial long-vowel patterns

Writes with transitional spelling (shz for shoes)

PRINT CONVENTIONS

Uses appropriate spacing between

words and/or sentences

Uses capitalization appropriately
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beginning of sentence
proper nouns
Uses end marks (period, question mark)
WRITER’'S CRAFT
Writes for an audience
Writes for a purpose
Revises own written work
Changes or adds to a picture

Changes pictures and/or words to
explain or embellish

Comments
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Meeting Individual Needs

The following strategies can help you adapt the Look, Read, and Play sections of the INSTANT
ReAaDErRs CD-ROMSs so the program can be used effectively with children who have special needs in
a variety of learning environments.

Extra Support

Encourage children who have difficulty distinguishing left and right or forward and backward to keep
a book near the computer. The book will remind them that just as turning a right-hand page takes
you forward in a book, clicking on the right-hand arrow takes you forward to the next screen. Turning
a left page takes you backward in a book just as clicking a left arrow returns you to the previous
screen.

Challenge
Some children might enjoy using the illustrations to tell their own story before they see or hear the
preview of the text.

Students Acquiring English

Help children discover that by clicking on the picture, they can hear the narration repeated as many
times as they need. If children have difficulty understanding what is being said, pair them with an
English-proficient partner to discuss what the narrator is saying on each screen.

Extra Support

Children can listen to the book as many times as they like before they attempt to read it with the
narrator and then read it independently. If you have selected the Record option in the Teacher
Management section, children can listen to the book, record their reading of it, listen to their
recording, listen to the book again, and record their reading of the book as often as they like.

Challenge
Children who need a challenge can read the book to a child who needs extra support.

Students Acquiring English

Children can work as buddies with English-proficient peers until they feel comfortable with the book.
Remind children that to hear a word that confuses them, they can click on it.
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For children who have difficulty reading the titles of the games, help them recognize the symbols for
the five choices:

Word Walk: feet on a tightrope
Phonics Fling: target

Think Twice: memory game
Letter Press: press

Color Write: paintbrush

Extra Support
Remind children to keep the mouse engaged the entire time they drag a word up to the tightrope.

Challenge
Challenge children to use the words on the tightrope to make new sentences on paper.

Students Acquiring English
Introduce the concepts of tightrope, gate, and unicycle and point out these elements in the screen
art before children begin playing the game.

Extra Support

Remind children to drag each letter they choose by keeping the mouse engaged until the letter or
letters are in the light gray area between the sides of the press. Help children locate the large lever.
Explain that they need to click on this lever each time they make a new word.

Challenge
Have children pick one of the words they have made in the game and use it in a written sentence.

Students Acquiring English

Introduce the concepts of press and lever by pantomiming these machines in use. Call attention to
these elements in the screen art before children begin the game. Prompt children to blend the
sounds as they drag the separate letters and phonemic elements together to make a word.

Extra Support

Before children play the Think Twice game, have them play a memory game with actual cards. Point
out that in this computer version of the game, there are a number of ways to make a match: match-
ing a word with its picture, matching a printed and spoken word, matching words to the letters they
begin or end with, matching rhyming words, and matching contractions to their corresponding
words. Children can find out which kind of match they need to make by listening to the dog’s direc-
tions—or by playing and drawing conclusions.
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Challenge
Challenge children to use words and pictures to make their own Think Twice games to play with
each other.

Students Acquiring English
For each game, review the particular matching activity with children before they begin to play. If chil-
dren are having difficulty, pair them with English-proficient peers to find matches together.

Extra Support

Explain that the up and down red arrows need to be clicked until the picture is directly across from
the target. Some children may have difficulty visualizing the path between the picture and the tar-
gets and will need extra practice manipulating the arrows.

Challenge
Challenge children to use the phonemic elements to make new words. Children might also work
with those who need extra support in making correct matches.

Students Acquiring English

To reinforce the word/picture relationship, remind children to click on the picture any time they want
to hear the word repeated. Since the directions change according to the phonemic focus, be sure
children clearly understand the match they are attempting to make in each version of the game.

Extra Support

Be sure children understand that they can make changes and corrections to their story or delete it
and start again. They can make changes before or after they hear their story read aloud. In addition,
make sure that children understand how to access the Word List. Point out that they can click on
any word to hear it read aloud.

Challenge
Challenge children to use all of the Word List words in their Color Write story. Point out that they can
continue their story on paper.

Students Acquiring English

Make sure children click on the dog’s face in the Word List title to access words they might use in
their stories. Point out that they can click on any word to hear it read aloud.
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The following off-computer activities will support the individual needs of a wide range of children.

Summaries
Encourage children to work in pairs to summarize each book before they move into the Play section
of the program. Invite children to retell the stories in their own words.

Headlines
Invite children to write a headline that summarizes each book they read in the INSTANT READERS CD-
ROMs. Children may write their headlines in the Color Write section in Play.

Word Wall

Invite children to create an illustrated class word-wall including many of the words found in the Color
Write section in Play. Encourage children to add words and their accompanying illustrations to the
word wall as they read new books in the INSTANT READERS CD-ROMSs.

Role-Playing Books
Children in small groups may choose a book from the INSTANT READERS CD-ROMSs to retell. They
may also pantomime the activities in the book.

Buddy Posters
Pair children with English-proficient peers to create posters telling other children about their favorite
books.

Using Sentence Strips

Create several sentence strips to accompany the books in the INSTANT READERS CD-ROMSs. Cut the
sentence strips into individual words, and, as children read the books, invite a volunteer to put each
sentence together and read it aloud.

Book Sequels
Have children write and illustrate sequels to some of the books in the INSTANT READERS CD-ROMSs.
Invite them to publish their stories by reading them aloud for their classmates.

Interviews with Book Characters
Challenge children to work in pairs to write questions to ask the characters in the books. Encourage
children to share their interviews by role-playing the interviewer and the book character.

My Journal

Invite children to imagine they are their favorite character from any of the books in the INSTANT
Reapers CD-ROMSs. Have children write a journal entry as if they were that character.
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Viewing and Printing Teacher Resources

For your convenience, additional resources are located on this CD-ROM.

Viewing Teacher Resources

To view the other Teacher Resources on this disk, double-click the Resource folder icon. Double-
click Words.pdf for the word cards and Records.pdf for the running record forms.

Printing Teacher Resources

Teacher’s Guide

To print this Guide, make sure your printer is turned on and selected. This Guide will print out as it
appears on the screen:

Macintosh

1. Choose Page Setup under the File Menu.

2. Select the Landscape Orientation icon.

3. Click OK.

4. Choose Print under the File Menu, and click OK.

Windows

1. Choose Print Setup under the File Menu.

2. Select the Landscape Orientation.

3. Click OK.

4. Choose Print under the File Menu, and click OK.
Windows 95

1. Choose Page Setup under the File Menu.

2. Select the Landscape Orientation.

3. Click OK.

4. Choose Print under the File Menu, and click OK.

Word Cards and Running Record Forms

Macintosh

1. Choose Page Setup under the File Menu.

2. Select the Portrait Orientation icon.

3. Click OK.

4. Choose Print under the File Menu, and click OK.
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Windows
1. Choose Print Setup under the File Menu.
2. Select the Portrait Orientation.

3. Click OK.

4., Choose Print under the File Menu, and click OK.
Windows 95

1. Choose Page Setup under the File Menu.

2. Select the Portrait Orientation.

3. Click OK.

4. Choose Print under the File Menu, and click OK.
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Software License Agreement and Limited Warranty

This program is licensed for use on one computer. It is against U.S. copyright law to copy this
program for use by others, to install the program on more than one hard drive, or to network the
program for use on more than one computer. Requests for permission to make copies of any part of
the program should be mailed to: Permissions Department, Harcourt Brace & Company, 6277 Sea
Harbor Drive, Orlando, Florida 32887-6777.

For complete license information, see the text file on the CD-ROM.

Additional Discs
When you order a basic CD-ROM package, you may order additional CD-ROM discs at reduced
prices. To order, call Customer Service at 1-800-225-5425.

Warranty and Replacements
Harcourt Brace School Publishers warrants this software against defects or damage for 60 days
from the invoice date.

Technical Support
If you have a technical question about installing or running this software, please call our technical
support hotline at 1-800-419-3900 for assistance. You may also receive interactive technical support

on the Web at http://www.hbtechsupport.com. A fax on demand service is also available at
1-800-352-1680

Copyright © by Harcourt Brace & Company

All rights reserved. No part of this publication may be reproduced or transmitted in any form or by any means, electronic
or mechanical, including photocopy, recording, or any information storage and retrieval system, without permission in
writing from the publisher, except as specifically enabled by the program and indicated by the presence of the print icon.

HARCOURT BRACE and Quill Design is a registered trademark of Harcourt Brace & Company.

Microsoft Windows is a registered trademark of Microsoft Corporation. Macintosh is a registered trademark of Apple
Computer Inc. Sound Manager is a registered trademark of Apple Computer Inc. Adobe Acrobat is a registered trade-
mark of Adobe Systems, Incorporated. ProVoice text-to-speech is a licensed product from First Byte. ProVoice® and
First Byte® are registered trademarks of First Byte, Torrance, CA.

Produced in the United States of America.
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Level 1-1A
AT A GLANCE

High-Frequency
Words Used in the

Phonic Elements
Used in the

Phonic Elements
Reinforced in

dog, girl, in, jumps,
the, what

Title INSTANT READER INSTANT READER Games
My Dog can, dog, jump, my, /ala, phonogram ap phonogram ap
run, sit, walk
What a Shower! a, bird, boy, cat, fala, inflection -s lala

Spring Pops Up

a, flower, lunch,
time

folo; final In/n, /p/p;
phonogram op

phonogram op

All Fall Down

all, bears, clowns,
dogs, down, fall,
the, tigers, up

final /n/n; Ip/p

final /n/n; Ip/p
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Level 1-1B
AT A GLANCE

Title

High-Frequency
Words Used in the
INSTANT READER

Phonic Elements
Used in the
INSTANT READER

Phonic Elements
Reinforced in
Games

Just Like You

big, funny, happy,
I'm, just, like, sad,
tall, you

contraction 'm, /a/a,
phonogram ad

phonogram ad

My Sister Is My
Friend

book, coat, finds,
friend, glad, is, my,
shoes, sister, snake

contraction 'm,
inflection -s, /o/o, final
ftlt, phonogram ad

phonogram ad

What Could It Be?

a, be, bear, bird,
could, it, not, snake,
what

/olo, final /t/t

phonogram ot

Butterflies

all, around, blue,
brown, fly, two,
white, yellow

long /ily, i—e

phonograms ot, ad,
and op
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Level 1-2A
AT A GLANCE

Title

High-Frequency
Words Used in the
INSTANT READER

Phonic Elements
Used in the
INSTANT READER

Phonic Elements
Reinforced in
Games

The Baby

has, me, my, rock,
the

/ala, olo, final /k/ck,
phonogram ock

phonograms ock, ot,
op

Bird’s Bad Day

a, bad, bird, day,
friend, here, is, lunch,
my, said, what

/a/a, initial clusters
with r; final /k/ck,
phonogram ack

phonogram ack

The Perfect Pet

a, bird, can't, cat,
dog, get, it’s, look,
mouse, pet, the, we

/ele; contractions
n't, 's; phonogram
et

phonogram et

“Help!” Said Jed

go, help, let's, mom,
now, said, thanks, up

final /I/ll; /ele; con-
traction 's;

phonograms et, ock

One More Time

all, big, can, for, here,
is, little, me, more,
mother, one, ride,
said, the, this, time,
you

/ele, initial clusters
with r, phonogram en

initial /tr/tr, /br/br,
[cricr

Where Babies Play

a, does, in, little,
mother’s, on, one,
play, this, where

/ele, contraction s,
double consonants,
phonogram en

phonogram en
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Level 1-2B
ATA GLANCE

Title

High-Frequency
Words Used in the
INSTANT READER

Phonic Elements
Used in the
INSTANT READER

Phonic Elements
Reinforced in
Games

Friendship Salad

all, apples, done,
eat, have, |, in, is, it,
let’s, mix, our, put,
the, together

/ifi; final /ks/x, d/d;
phonogram it

phonograms ot, et,
it

Garden Birthday

birthday, cake, grass,
yes

final /d/d

final /d/d, /t/t, In/n

Good-bye,
Fox

cat, fox, goes,
good-bye, jump, over,
rocks, the, there

initial /kw/qui; final
Iks/x, 1d/d, Ikick; /ifi;
phonogram ick

phonograms ick,
ock, ack

After Goldilocks

after, all, bear, beds,
chairs, good, heads,
nights, not, of, quiet,
said, three, two

initial /kw/qui; final
/d/d, /k/ck; phono-
gram ick

phonograms ick,
ock, ack

One Little Slip

a, began, father, little,
mother, one, she, to,
took, trip, when

initial clusters with r;
fili, phonogram ip

phonogram ip

My Family Band

be, dancing, family,
father, grandma,
her, his, I, mother,
my, playing, singing,
there, will, with

fifi, initial clusters
with r

initial /tr/tr, /gr/gr,
/dr/dr
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Level 1-3A

AT A GLANCE
High-Frequency Phonic Elements Phonic Elements
Words Used in the Used in the Reinforced in
Title INSTANT READER INSTANT READER Games
What Is In the Box? a, big, box, dog, /ch/ch; initial /th/th; Ichich, final /ks/x
eyes, |, in, is, it, it's, final /ks/x

little, look, mouse,
much, no, nose,
not, one, see, so,
tail, the, two, very,
wanted, what

Four Very Big a, all, and, as, big, /ch/ch; initial final /m/m, /d/d,
Beans but, can, did, for, fthith; final Iks/x
four, gave, get, /m/m, /d/d

grandma, have, here,
I, is, look, lot, me,
mom, much, now,
one, see, she, so,
this, three, to, two,
very, wanted, you

| Was Just About to about, bed, but, /u/u, contraction n't /ulu
Go to Bed don't, duck, go,
have, I, just, light,
my, so, to, was

What Time Is It? bird, eat, fish, is, it, fifi fifi, lulu
mom, sleep, squirrel,
time, to, what

Know Your Birthday a, birthday, cake, /u/u; medial phonogram ug
Manners chair, do, eat, hands, /blb, Iplp;
happy, have, know, phonogram ug

not, on, please, put,
sit, table, the, use,

with, your
All | Did a, all, and, but, /u/u; phonogram ug /ulu, lolo,
cake, clean, did, lala

eat, fix, for, hop,
house, |, in, lots,
mom, much, my, of,
on, out, room, run,
said, table, the,
then, time, to, too,
up, was
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Level 1-3B
AT A GLANCE

Title

High-Frequency
Words Used in the
INSTANT READER

Phonic Elements
Used in the
INSTANT READER

Phonic Elements
Reinforced in
Games

Frog’s Day

a, and, day, do,
does, friends, frog,
going, grass, have,
he, hops, I'm, in,
jumps, lake, music,
my, now, oh, plays,
rock, says, sing,
sits, sleep, take,
the, to, what, yes

final /z/s, /k/ck,
contraction 'm,
phonogram ub

phonograms
ub, un, ip

Famous Feet

again, and, at, bad,
big, can, cow, feet,
flying, friends, if,
know, like, little, look,
ones, running, see,
so, story, tell, the,
those, to, which,
would, you

lulu;
phonogram ub

/ulu

Dancing

a, air, and, is, legs,
music, on, round,
something, the,
through, to, turning,
watch, with, your

/chitch,
final /z/s

/chitch, ch

A Place For
Nicholas

a, and, any, are,
back, but, come,
dad, did, for, has,
have, he, here, his,
house, I'll, is, just,
little, make, mom,
not, now, own,
place, room, said,
see, soon, this, too,
wanted, you

contraction 'll,
final /f/ff

final /f/ff, /I/l, /t/tt
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Level 1-3B
ATA GLANCE

Title

High-Frequency
Words Used in the
INSTANT READER

Phonic Elements
Used in the
INSTANT READER

Phonic Elements
Reinforced in
Games

Old MacDonald’s
Fun Time Farm

can, cow, did, find,
fun, hen, horse,
mouse, old, pig,
sheep, them, this,
time, you

/th/th, phonogram en

phonogram en

Play Ball!

ball, bear, cat, dog,
everyone, here,
horse, pig, play,
sheep, stand, stop,
who, will

/chitch

[chitch, /t/t
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Level 1-4A
AT A GLANCE

Title

High-Frequency
Words Used in the
INSTANT READER

Phonic Elements
Used in the
INSTANT READER

Phonic Elements
Reinforced in
Games

Lost and Found

all, and, around,
big, cat, cow, don't,
duck, eat, find,
found, grow, have,
help, hen, her,
how, I, I'm, just,
know, little, looked,
lost, me, must, not,
of, pig, said, sheep,
the, them, these,
they, who, will, you

initial clusters with I;
lele; lala;
phonogram at

phonograms at, ub,
ap

Red

and, bed, come, did,
each, for, found,
friends, got, her,
herself, home,
house, in, left,
looked, looks,
morning, Mrs., my,
night, not, of, other,
out, red, said, saw,
see, some, that, the,
they, to, you

lele; lala;
phonograms ed, at

phonograms ed, at,
en

What's Up?

and, bats, birds,

but, by, clouds, fly, I,
in, is, kites, know,
must, nothing, sky,
stars, stay, sun, the,
they, up, what's,
with, yes, you

final clusters with t;
/ulu; final /z/s

lulu, lele
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Level 1-4A
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Title

High-Frequency
Words Used in the
INSTANT READER

Phonic Elements
Used in the
INSTANT READER

Phonic Elements
Reinforced in
Games

The Little Chicks
Sing

and, are, by, can,
cold, come, day,
eat, feet, food, hen,
her, here, is, little,
mother, my, need,
next, says, sing, sit,
sleep, take, the,
then, under, until,
us, we, you, your

/olo; lulu;
final /z/s

/oo

Look What | Can
Read

a, and, anything, at,
book, can, dad,
everything,
grandma's, home, I,
letter, like, look, out-
side, read, school,
story, that's, what,
with

/olo—e;
possessive ’s;

phonograms
ope, oke, ock

The King Who
Loved to Dance

a, all, and, around,
away, bees,
couldn't, cows,
dance, danced, day,
down, everyone, he,
horses, into, king,
knew, long, loved,
outside, rope, sat,
song, the, then, to,
town, was, went,
what, who, with,
without

inflections -ed, -ing
(drop e);
possessive ’s;
/olo—e;

initial clusters with I;
phonogram ope

/olo—e
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Title

High-Frequency
Words Used in the
INSTANT READER

Phonic Elements
Used in the
INSTANT READER

Phonic Elements
Reinforced in
Games

The Night Walk

a, air, am, behind,
brown, care, flying,
for, go, going, good,
here, high, him, I,
I'll, in, inside, it's,
keep, light, might,
night, not, of, on,
take, the, this, time,
to, under, up, walk,
what's, you

ili, i-e, -igh;
phonogram ight

phonograms ight,
oke, ope

My Wild Woolly

a, and, ate, ball, bed,

bed, but, go, good,
have, he's, I, in, into,
is, mom, my, night,
no, out, play, right,
said, that, the,
there's, time, too,
tree, under

lifi, i—e, -igh;
phonogram ight

fili, i—e

How 100
Dandelions Grew

a, along, and, ball,
began, boy, came,
day, down, fell,
flower, grew,
ground, grow, how,
in, into, it, little,
night, on, one,
opened, plant, seed,
the, then, to, turned,
up, went, white,
wind, yellow

lelea, ee; Ish/sh:;
/hw/wh

/sh/sh, lwh/wh,
/chich

Harcourt Brace School Publishers

52




Level 1-4B

AT A GLANCE

Title

High-Frequency
Words Used in the
INSTANT READER

Phonic Elements
Used in the
INSTANT READER

Phonic Elements
Reinforced in
Games

Green, Green,
Green

be, blue, brown,
color, dog,
everything, fly, for,
game, green, have,
high, home, I, I'm,
in, is, kite, my, own,
pet, play, red, room,
sky, sun, this, to,
tree, up, yellow

lelee;
initial /hw/wh;
/sh/sh

lelee

The Green Grass
Grows All Around

a, all, and, around,
bird, did, ever, grass,
green, ground,
grows, in, is, my, on,
see, some, that, the,
there, tree, you

final nd, st;
medial /n/n; /ifi

final nd, st

Slowpoke Snail

a, and, away, bees,
birds, but, by, close,
do, does, doesn't,
eat, fast, fine, fish,
found, frogs, goes,
have, he, head, he's,
hides, his, hungry, if,
in, inside, is, just,
know, little, most,
move, not, now, or,
slow, so, swims,
takes, the, thinks,
time, to, too, want,
why, you

fLrlaI nd, st;
lili—e; Ish/sh;
phonogram ine

final nd, st
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Title

High-Frequency
Words Used in the
INSTANT READER

Phonic Elements
Used in the
INSTANT READER

Phonic Elements
Reinforced in
Games

Skimper-Scamper

a, an, and, animals,
are, as, back, ball,
big, black, blue, cat,
clean, coming, dog,
door, fun, get, give,
go, got, had, help,
her, here, if, I'll, it's,
jump, just, made,
making, mom,
mouse, no, of, off,
oh, on, out, outside,
paints, paper, play,
playing, ran, ready,
ride, rope, said,
small, stop, that, the,
then, this, time, to,
took, up, well, with,
worked, yelled,
yellow, you, you're

contractions 're, 'll;
initial clusters with
s; inflections -ing;
fili-e

lili—e

Today Is Monday

art, birthday, day, fun,
happy, I, is, music,
play, say, should,
show, that, today,
wasn't, well

initial clusters with s;
inflection -ing;
phonogram ime

initial clusters with s

If You Were a Bat

a, all, alone, and,
bat, but, clean, coat,
day, down, eat,
every, feet, fly, go,
home, if, in, it, keep,
long, might, morn-
ing, night, not, off,
open, out, sleep,
sun, the, them,
then, to, went, were,
when, with, would,
you, your

initial clusters with I;
/oloa;
phonogram oat

loloa, lili-e, lelee
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High-Frequency
Words Used in the
INSTANT READER

Phonic Elements
Used in the
INSTANT READER

Phonic Elements
Reinforced in
Games

Hare’s Big Tug-of-War

across, alone, and,
are, as, ate, big,
boat, but, can't,
eating, end, have,
he, his, how, is,
leave, let's, looked,
me, more, morning,
next, of, on, one,
other, out, pulled,
rope, said, sat, saw,
shouted, side, than,
that, the, them, then,
those, to, together,
took, until, up,
window, you

final clusters with t;
/olo, oa, 0—€;
phonogram oat

/olo-e

Harcourt Brace School Publishers

55




Level 1-5A
AT A GLANCE

Title

High-Frequency
Words Used in the
INSTANT READER

Phonic Elements
Used in the
INSTANT READER

Phonic Elements
Reinforced in
Games

Davy Crockett and
the Wild Cat

a, and, as, back,
bear, big, bigger,
but, by, cat, could,
dark, day, did, fish,
floor, for, gave, got,
great, he, help, her,
him, his, hold, home,
in, into, it, kitten, let,
like, long, love,
make, one, opened,
out, ride, run, say,
she, showed, swim,
tail, that, the, was,
well, were, with

Ishish; lalay, a—e;
inflection -ed;
phonogram ate

/sh/sh

Every Cat

a, and, bed, cat,
every, feed, friend,
give, help, in, is, it,
let, needs, on, pet,
plants, play, sit,
sleep, someone, sun,
that, the, to, toy, wait,
water, when, with,
you

/alai, ay; inflection -
ed; /sh/sh; /wh/wh

/wh/wh, /sh/sh,
/ch/ch

Plenty of Pets

a, all, and, animals,
calls, came, cats,
dad, ducks, five, for,
four, games, get,
have, heads, helps,
home, I, into, is, it,
kinds, liked, little,
made, mom, my,
needs, new, now,
of, on, pets, pigs,
play, read, she,
snake, so, some,
stay, stories, swim,
take, the, their,
them, they, to, took,
two, watched, water,
went, while, with

initial clusters with s;
lelea; [alay,

a-e; inflections -ed;
phonogram ake

phonograms ead,
oat, ake

Harcourt Brace School Publishers

56




Level 1-5A
AT A GLANCE

Title

High-Frequency
Words Used in the
INSTANT READER

Phonic Elements
Used in the
INSTANT READER

Phonic Elements
Reinforced in
Games

Pet Day

a, all, an, and,
anything, because,
big, bird, brought, but,
by, come, couldn't,
day, didn’t, do, dog,
don't, every,
everyone, eyes,
found, front, get, had,
have, he, her, his,
hold, I, idea, in, it, its,
knew, know, last, let,
long, loved, monkey,
most, mouse, my, of,
on, out, outside, pet,
pig, pretty, rabbit,
school, she, snake,
something, started,
steps, take, the, their,
then, this, to, too,
trained, tricks, turtle,
very, walked, went,
what, with, would,
year

initial clusters with
s; /a/ai, ay, a—e€;
inflections -ed, -ing;
phonograms ake,
ead

initial /st/st, /sn/sn

How to Make a Lion
Mask

a, all, and, animal, be,
can, color, cut,
decorate, do, don't,
draw, eyes, first, get,
go, happy, hear, here,
how, if, is, it, it's, kind,
know, lines, lion,
make, need, nose,
now, of, on, or, out,
paper, sad, so, stick,
that, the, then, these,
things, to, try, use,
what, when, where,
will, you, your

lele, ea, ee; final
clusters with t;
phonogram eed

lelee
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High-Frequency
Words Used in the
INSTANT READER

Phonic Elements
Used in the
INSTANT READER

Phonic Elements
Reinforced in
Games

Pet Riddles and
Jokes with Franny
and Frank

a, always, and, are,
ate, away, barking,
be, best, bird, but,
can't, cat, did, do,
does, dog, don't,
ever, eyes, fine,
first, fish, food, for,
front, getting,
glasses, good,
grow, had, have,
his, how, I, I'm, in,
is, just, kind, know,
like, mouse, my,
need, new, nice, of,
old, on, one, pet,
put, puts, quiet,
rabbit, ran, read,
say, see, she, sign,
sky, some, stepped,
the, their, thing,
think, to, up, want,
water, what, what's,
where, why, with,
yet, you, your

lele, ea, ee; com-
pound words; final
clusters with t;
phonogram eed

/elea

Harcourt Brace School Publishers

58



Level 1-5B
AT A GLANCE
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High-Frequency
Words Used in the
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Phonic Elements
Used in the
INSTANT READER

Phonic Elements
Reinforced in
Games

Lunch in Space

and, as, away,
because, boxes,
can, clean, come,
cook, do, dogs,
don'’t, door, drink,
even, finds, first,
get, good, have,
having, here, home,
hot, how, if, in, it,
it's, lunch, make,
mix, not, on, open,
out, part, people,
put, same, seat,
show, stick, take,
the, them, these,
they, thing, this, to,
up, water, we, well,
we’ll, will, yes, you

/olow; /alay, a—e;
initial clusters with
fl;

phonogram ame

phonograms ame,
oat, ake

Alien Vacation

a, about, at, been,
can, everyone,
flowers, for, get, go,
great, |, is, know,
lakes, last, let's,
look, my, never, new,
oh, on, people,
picture, please,
rocks, see, should,
so, take, tall, that,
there, they, this,
time, to, wait, we,
we've, wet, what,
where

/o/ow; long /a/ae,
a=e; initial clusters
with |

/ala, a—e
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Words Used in the

Phonic Elements
Used in the

Phonic Elements
Reinforced in

Title INSTANT READER INSTANT READER Games
How the Sky Got Its ago, air, all, and, lar/ar; [ili—e, igh; larlar;
Stars animals, another, phonogram ar lifigh

around, asked, but,
can, can't, could,
dark, day, do, each,
eat, far, has, he,
helped, hills, how, I,
in, into, it, just,
lakes, long, looked,
lots, made, make,
maybe, new, night,
not, of, on, one,
picked, play, put,
said, saw, sky,
sleep, small, so,
stars, that, the,
them, these, they,
things, this, to,
trees, up, use, was,
watched, we, went,
what, when, while,
why, with

Let’s Visit the Moon

air, are, many, at,
be, black, blue, can,
cold, comes, far,
food, from, get, has,
home, hot, is, it,
let’s, like, long, lots,
night, no, on, one,
places, rocks, sky,
stay, sun, take, the,
there, things, this,
to, water, we, we’'ll,
wear, what, will,
yes,

/il igh; final clusters
with Id; phonograms
ide, ar

lalay; /ar/ar;
jiligh
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High-Frequency
Words Used in the
INSTANT READER

Phonic Elements
Used in the
INSTANT READER

Phonic Elements
Reinforced in
Games

World

Dream Around the

a, around, as, at,
ate, because, big,
both, breakfast,
came, children, city,
family, first, for,
friends, game,
great, had, helped,
her, home, how, I,
in, it, knew, last,
make, me, mouse,
my, new, next, night,
on, or, other, put,
quiet, sun, that, the,
this, to, together,
toy, tried, turtle, up,
walked, was,
watched, we, went,
when, where, with,
world

lelea, ee; /chitch;
/th/th; inflection -ed;
phonogram eam

phonograms eam,
eed, ake
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Phonic Elements
Used in the
INSTANT READER

Phonic Elements
Reinforced in
Games

Clean-Up Day

a, across, all, and,
any, as, at, away,
bike, box, brother,
buy, cleaned, come,
could, dad, day,
didn’t, dinner, don't,
end, everyone,
family, first, fixed, for,
from, gave,

getting, give, good,
grandma, great, had,
have, his, house, in,
it, like, little, looked,
lots, mom, money,
Mr., my, need, never,
new, of, old, on, or,
party, people, puts,
ready, some, street,
take, the, these,
things, this, tires, to,
today, toys, up,
washed, we, were,
when, which, whole,
will, with, worked

lelea, ee; /thith;
inflection -ing

lelee
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INSTANT READER

Phonic Elements
Used in the
INSTANT READER

Phonic Elements
Reinforced in
Games

Henry

a, after, and, are,
asked, at, beautiful,
because, big,
brothers, clean,
come, could, didn't,
do, down, feet, first,
fly, four, go, ground,
had, has, have, he,
here, his, it, left,
legs, like, long,
loved, mother, must,
my, nothing, oh,
please, put, said,
short, sisters,

small, smiled, the,
them, then, they,
time, to, two, up,
use, wasn't, why,
you, your

initial clusters with
s, inflection -ed

initial /sm/sm;
Isp/sp, /st/st

Silly Aunt Tilly

a, am, and, back,
bear, bees, behind,
big, birds, blue,
brought, came,
chair, city, day, eat,
fish, for, from,
green, he, her,
home, how, I, in,
left, me, one, ride,
sad, say, she,
showed, something,
thank, the, to, tree,
with, without, you

/yoo/u—e; long /o/ow;
inflections -ed,
phonogram ow

/o/low, o—e
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Words Used in the
INSTANT READER

Phonic Elements
Used in the
INSTANT READER

Phonic Elements
Reinforced in
Games

What's New at the
Z007?

all, and, animals,
asked, at, ate, away,
bad, bear, but, cold,
did, feeding, fish,
food, funny, got,
hard, hear, in, is,
just, knew, like,
lion’s, new, no, oh,
over, please, ran,
saying, so, some,
something,
swimming, talking,
the, there, they, time,
to, too, took, turned,
was, water, were,
wet, what, what's,
with, would, you, zoo

/olo,

/elee; initial clusters
with s,

phonogram eek

/elee
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Phonic Elements
Used in the

Phonic Elements
Reinforced in

Title INSTANT READER INSTANT READER Games

The Strongest One a, all, along, am, an, | /o/ow, o-e; long lelea,
of All and, asked, back, lelea, ee; initial lolow,
beautiful, but, can, clusters with sm, st fil i-e

cloud, comes,
down, fall, far,
father, feet, find,
found, had, happy,
her, hill, him, hole, I,
in, keep, kind, lake,
left, lived, loved,
mother, mouse,
move, much, my,
not, of, oh, once,
one, our, over, said,
sits, small, so, still,
sun, the, there, they,
time, to, under, up,
upon, very, wanted,
was, went, when,
who, will, you
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